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E-Reader, e-Ink, e-Stores, who 
knew there were so many e– thing-
ies? 
At the April meeting we started 
talking about e-
Readers and spent 
the better part of the 
next 2 hours on the 
subject. Lots of ques-
tions from the audi-
ence and lots of infor-
mation from Bear and 
his trusted sources. 
Bear admitted that he had never 
even held an e-reader but he, very 
adequately, went on to tell us eve-
rything he knew about them. 
There are e-readers and then there 
are e-readers +. The e-readers let 
the user download books and arti-
cles from the e-stores to read at 
their leisure. 
Full fledged novels; novellas; me-
dia columns, and more. The e-
readers +, in addition to the read-
ing material, also let you browse 
the net, check your email and 
stocks, view videos, and more. 
Some of the e-reader names may be 
familiar: Amazon’s Kindle, Barnes 
& Noble Nook, Sony Reader and 
Borders Kobo. 
Depending on who markets them 
the library lists can be quite exten-
sive. Amazon’s Kindle store boasts 
32K+ titles and in Jan of 2011 
Amazon reported for every 100 pa-

perback 
books sold, 
115 e-
books for 
the Kindle 
were sold. 
To say 
that the e-
readers 
are popu-

lar would be an understatement. 

The new Kindle 3 can hold up to 
3,500 books. So, if you purchase 
them outright you can stock up for 
an entire summer of reading while 

sipping those refreshing 
mint juleps. 
Here’s a link to a de-
tailed comparison chart 
for the e-Readers al-
ready mentioned and 
the Apple iPad2.  

http://tinyurl.com/ygr6fjq  
Prices vary according to 

vendor. You can expect to spend as 
little as $140 for a Kindle 3 w/o Wi-
Fi and  more than $800 for the 
high end iPad 2. Of course, the 
more expensive the model the more 
features it has. 
Display sizes vary from 6” to 10”. 
Screen resolution rivals that of 
your PC monitor, i.e. 800x600, 
768x1024, etc. Black and white dis-
plays have a 16-level gray scale 
capability. Which means the con-
trast of the text is better than on 
the color models. 
Some models use e-ink (Kindle) 
and others use backlighting. The e-
ink is simply black text on a white 
background. Backlit models can 
display in color as well as black 
and white but are much harder to 
see in harsh sunlight. 
All have 3G Wi-Fi (just like your 
cell phone). The Apple iPad also 
comes with Bluetooth. 
The Kindle has 4 GB internal stor-
age, enough for 3,500 books. The 
Nook, 2 GB enough for 1,500 books 
and uses a Micro SD expansion slot 
of a 16 GB card to hold up to 
17,500 books. 
 The Sony Reader 2 GB, up to 
1,200 books but also uses a dual 
memory card expansion with space 
for 50,000 books in 32GB. 
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The Nook, Sony and iPad all have 
touch screen ability. 
Depending on the model and the 
amount of us-
age battery 
life can be as 
little as 10 
hours and up 
to a month, 
with wireless 
turned off. 
Lightweight Kindle eReaders tip 
the scale as 8.7 ounces. The other 
weigh as little as 9.6 ounces for the 
Nook and Sony, with the iPad com-
ing in at a hefty 1.33 pounds. 
Since eReaders are so popular, and 
there are so many to choose from, 
shop around for the best price on 
the one that best suits your needs. 
Visit a vendor and get the look and 
feel of your favorite. 

Aloha, 
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File tab of the ribbon and 
click Options.) 

2. At the left side of the dia-
log box, click Advanced. 

3. Scroll through the list of 
options until you see the 
Display  Options  for  This 
Worksheet section. 

4. Make sure the Show Page 
Breaks  check  box  is  se-
lected. 

5. Click on OK. 

Printing Odd or Even Pages 
There may be many times that you 
need to print either odd or even 
pages in a Word print job. For in-
stance, you may want to put your 
pages through the printer twice so 
you can print on both sides. This is 
easy to do in Word by following 
these steps: 

1. Press CTRL+P. Word displays 
the Print dialog box. 

2. Adjust the printing settings as 
desired. 

3. Using the Print drop-down list 
at the bottom of the dialog box, 
choose either Odd Pages or 
Even Pages, as desired. (Make 
sure you use the Print drop-
down list, not the Print What 
drop-down list.) 

4. Click on OK. Your document is 
printed. 

The above steps work great in any 
version of Word up through Word 
2007. If you are using Word 2010, 
then the Print dialog box was done 
away with. You should follow these 
steps, instead: 

1. Press CTRL+P. Word displays 
the File tab of the ribbon, with 
printing options visible in the 
tab. 

2. Adjust the printing settings as 
desired. 

Prez Lou 

Read and all of Lou’s columns, 
@ Oceanic Around Town. Visit 
http://tinyurl.com/363qew 

Da Prez Sez column is 
on hiatus until further 
notice. 
Lou and his column 
will return in the near 
future. 

We’re going to do something dif-
ferent in this section this month. 
Lou normally has his full featured 
column in this space but, since he 
is “under the weather” we’re going 
to fill this up with MS Word and 
Excel Tips from Sharon Parq As-
sociates. 

The TUG receives these monthly 
tips that show up in an issue if 
space allows. Well, space allows 
this and, maybe, future issues. So, 
here’s some on Word and Excel. 
These work on Office 2003, 2007 
and 2010. Keep ‘em handy for 
when you need ‘em. 
Inserting the Template Name 
in Your Document 
Every Word document has a tem-
plate attached to it. Depending on 
your version of Word, this tem-
plate defines things such as your 
menus,  toolbars,  macros,  and 
styles (among other things). If you 
do  not  explicitly  attach  a  tem-
plate, then Word uses the Normal 
template. 

The name of the template file at-
tached to your document can be 
inserted into your document and 
updated automatically. To do this, 
follow these steps: 

1. Position  the  insertion 
point where you want the 
template file name to ap-
pear. 

2. Display the Field dialog 
box.  (In  Word  2007  or 

Word 2010 display the In-
sert tab of the ribbon and 
then choose Quick Parts | 
Fields from the Text group. 
If you are using an older 
version  of  Word,  choose 
Field  from  the  Insert 
menu.) 

3. In  the  Categories  list, 
choose Document Informa-
tion. 

4. In  the  Field  Names  list 
choose Template. 

5. Click on OK to close the 
dialog box and insert your 
field. 

Controlling the Display of Page 
Breaks 
When you are formatting a work-
sheet, you may want to see where 
Excel  will  insert  page  breaks  in 
your printout. This is easily done by 
using the Print Preview option, or 
by using the Page Break Preview 
feature. You may also want to see 
the page breaks when you are again 
editing the worksheet. 

Excel can display page breaks as 
dashed lines between rows or col-
umns on your worksheet. To enable 
this  display,  simply  follow  these 
steps: 

1. Choose  Options  from  the 
Tools menu. Excel displays 
the Options dialog box. 

2. Make sure the View tab is 
selected. 

3. Make sure the Page Breaks 
check box is selected. 

4. Click on OK. 
If you are using Excel 2007 or Excel 
2010 then the steps to follow are a 
bit different: 

1. Display the Excel Options 
dialog box. (In Excel 2007 
click the Office button and 
then click Excel  Options. 
In Excel 2010 display the 


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If you want to ensure that Word 
doesn’t make that assumption, you 
need to follow these steps to turn 
off the offending feature in Word 
97 through Word 2003: 

1. Choose Options from the 
Tools  menu.  Word  dis-
plays the Options dialog 
box. 

2. Make sure the Edit tab is 
selected. 3. Make  sure 
the When Selecting, Auto-
matically  Select  Entire 
Word check box is cleared. 

4. Click on OK. 

You can follow these steps if you 
are using Word 2007 or Word 2010: 

1. Display the Word Options 
dialog box. (In Word 2007 
click  the  Office  button, 
then  choose  Word  Op-
tions. In Word 2010 dis-
play the File tab of the 
ribbon,  then  click  Op-
tions.) 

2. Click Advanced at the left 
side of the screen. 

3. In  the  Editing  Options 
area, make sure the When 
Selecting,  Automatically 
Select Entire Word check 
box is cleared. 

4. Click on OK. 

That should be enough to keep you 
busy until next issue. 

 

Aloha, 

Jim 
Copyright © 2011 by Sharon Parq 
Associates, Inc. Reprinted by per-
mission. 
Thousands of free Microsoft Excel 
and Word tips can be found online 
at http://excel.tips.net and http://
word.tips.net. 
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3. Using the first drop-down list 
under  the  Settings  heading, 
choose Only Print Odd Pages or 
Only Print Even Pages, as de-
sired. 

4. Click on Print. Your document 
is printed. 

Displaying a Hidden First Col-
umn 
Excel makes it easy to hide and 
unhide columns. What isn’t so easy 
is displaying a hidden column if 
that column is the left-most col-
umn  in  the  worksheet.  For  in-
stance, if you hide column A, Excel 
will  dutifully follow out your in-
structions. If you later want to un-
hide column A, the solution isn’t so 
obvious. 

To unhide the left-most columns of 
a worksheet when they are hidden, 
follow these steps: 

1. Press  F5.  Excel  displays 
the Go To dialog box. 

2. In the Reference field at 
the bottom of  the dialog 
box, enter A1. 

3. Click on OK. Cell A1 is 
now selected, even though 
you cannot see it on the 
screen. 

4. Unhide the column. (In 
Excel 2007 or Excel 2010, 
display the Home tab of 
the ribbon and click For-
mat | Hide & Unhide | 
Unhide Columns. In older 
versions of Excel choose 
Format | Column | Un-
hide.) 

Another way to display the first 
column is to click on the header for 
column  B,  and  then  drag  the 
mouse to the left. If you release the 
mouse button when the pointer is 
over the gray block that marks the 
intersection of the row and column 
headers (the blank gray block just 
above the row headers), then col-

umn B and everything to its left, 
including the hidden column A, are 
selected. You can then unhide the 
column. 

A third method is even niftier, pro-
vided you have a good eye and a 
steady mouse pointer. If you move 
your mouse pointer into the col-
umn header area, and then slowly 
move it to the left, you notice that 
it turns into a double-headed arrow 
with a blank spot in the middle as 
you position the pointer over the 
small area immediately to the left 
of the column B header. This dou-
ble-headed arrow is a bit difficult 
to describe; it looks most closely 
like the double-headed arrow that 
appears  when  you  position  the 
pointer over the dividing line be-
tween column headers. It is differ-
ent, however, because instead of a 
black line dividing the double ar-
rows,  there  are  two  black  lines 
with a gap between them. 

When your mouse pointer changes 
to this special double-headed ar-
row, all you have to do is right-
click and choose Unhide. Your pre-
viously  missing  column A magi-
cally reappears. 

Automatically Selecting Words 
When you are editing your docu-
ment, there are many times that 
Word tries to guess what you are 
doing and then complete your task 
for you. This helpfulness can be 
aggravating  at  times.  One  such 
instance is when you are trying to 
use the mouse to select text from 
the middle of one word to the mid-
dle of another. Whenever you click 
inside a word and then start drag-
ging the mouse, Word assumes you 
want to make a selection. As soon 
as you move the mouse pointer out-
side  the  word,  the  program as-
sumes you wanted to select the en-
tire first word in which you origi-
nally clicked. 

http://excel.tips.net
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May 1st, often called 
May Day, just might 
have more holidays 
than any other day of 
the year. It's a cele-
bration of Spring. It's 
a day of political pro-
tests. It's a neo-pagan 
festival, a saint's feast 
day, and a day for 
organized labor. In 
many countries, it is a 
national holiday. 

Mother’s Day 
May 8—Mom’s Spe-
cial Day. 

Memorial Day 
May 30—Fly the flag 
to honor those who 
have served and are 
serving our Country. 
God Bless America. 

stored. The result? You get more 
done—faster. 

Windows 7 comes with libraries for 
documents, music, pictures, and 
videos. But you can personalize 
these, or create your own, with just 
a few clicks.  

You’ve just returned from a two-
week vacation. During that time 
you took hundreds of digital pic-
tures. You load them on an exter-
nal hard drive. Now you want to 
tell Windows 7 where you have 
them stored. 

Open Windows Explorer and click 
on Libraries. Create a new folder, 
you name it Vacation 2011 Photos.  
Drill down to the location, i.e. 
F:/Vacation 2011 and then tell 
Windows where to find all your 
photos by clicking on the Add this 
folder to Libraries. Your photos are 
still physically located on the exter-
nal drive—but now the directory 
tree shows up in a single window. 

This is important because it means 
you aren’t taking up precious hard 
disk space with duplicate copies of 
all your files. The Library can be 
considered the master Index. 

Using Libraries you can 

♦ Create new ones 

♦ Arrange items by folder name, 
date and other properties 

♦ Include or remove a Library 

♦ Change the default save loca-
tion for any file 

Here’s a link to an easy to under-
stand tutorial on Libraries. Have 
fun. http://tinyurl.com/ycrcelb  

Aloha, 

Jim 
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Pres—Lou Torraca We’re going to talk Libraries. Not 
the brick and mortar tax payer 
funded libraries, but the digital 
ones you find in Windows 7. 

This is a feature introduced in 
Win7 to assist the user with easier 
filing and finding of their docu-
ments. 

When you open Windows Explorer, 
at the top of the left pane you’ll see 
Library. There will be sub-folders 
in it. Each time you create a new 
folder, or document you can add it 
to the Library with just a few 
mouse clicks. This puts everything 
in a place of your choosing and a 
place that you can readily find 
without having to resort to a 
search. 

First, an official description and, 
second how you can use them to 
your advantage. 

Windows XP and Vista used spe-
cial sets of folders to store your 
items. My Documents, My Music, 
My Pictures, are a few you should 
be familiar with. In Vista they 
were called Known Folders and the 
“My” was dropped from the name. 

You may have noticed that every 
time you saved a document the de-
fault storage area was in one of the 
My folders. Pictures went to My 
Pictures; documents were saved in 
My Documents, and so on. 

While most users created more and 
more sub-folders within the My 
folders, the ability to find what you 
were looking for was hampered by 
the sheer volume of sub-folders. 

Windows 7 Libraries was designed 
to solve that dilemma. They make 
it easier to find, work with, and 
organize files scattered across your 
PC or network. A library brings 
your stuff together in one place—
no matter where it's actually 

Libraries 

http://tinyurl.com/ycrcelb
http://www.the-tug.org

